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Freeway™ is a trademark of SoftPress Systems Limited. SoftPress® is a 
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jurisdictions. All other company and product names are trademarks or 
registered trademarks of their respective owners. Features and specifications
are subject to change without notice.
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FREEWAY FACTS AND FIGURES

Developer: SoftPress Systems Ltd – http://www.softpress.com/
Product Name: Freeway™
Platforms: Mac OS – both PowerMac and 68K
Version: 1.0

PRODUCT SUMMARY
The most powerful and intuitive Web site design and production application
for graphic designers. With Freeway you do not require any knowledge of
HTML to produce superbly designed Web sites quickly and profitably.

AVAILABILITY

Freeway 1.0 started shipping on September 30th 1997
PRICING

US$299 when purchased directly from SoftPress Systems (£199 in the United
Kingdom). We offer a 50% education discount and attractive volume discounts.
For more detailed information on pricing please check out our web site.

SPELLCHECKING LANGUAGES

Freeway is supplied as standard with US and UK English dictionaries for
spellchecking and hyphenation. We can supply additional dictionaries – the lan-
guages available are Catalan, Czech, Danish, Dutch, Finnish, French, German,
Italian, Norwegian, Portuguese, Spanish and Swedish.

HOW TO PURCHASE FREEWAY
Freeway 1.0 will be sold worldwide directly by SoftPress and customers will be
able to purchase and download the product from the SoftPress Web site. 
Online: http://www.softpress.com/
Telephone sales: UK: 0800 731 3425 

US: 1 800/853-6454
International: +44- (0)-1993-882588

Email: sales@softpress.com
We are also appointing dealers and distributors in the near future and details
of these new channels will be posted on our Web site. Our intention is to cre-
ate an effective blend of direct and indirect sales channels to ensure that cus-
tomers have the right level of access and support across the world.

CONTACT INFO
SALES: SUPPORT:
sales@softpress.com support@softpress.com

GENERAL INFO:
info@softpress.com

SOFTPRESS OFFICES: 
United Kingdom United States
SoftPress Systems Ltd SoftPress Systems Inc., 
8, Blenheim Office Park 3020 Bridgeway, Suite 310
Long Hanborough Sausalito, CA 94965
Oxon OX8 8LN, United States
Tel:  +44-1993-882588 Tel: 415/331-4820
Fax: +44-1993-883970 Fax: 415/331-4824
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1. PRODUCT OVERVIEW

WHAT IS FREEWAY?
Freeway is SoftPress Systems’ stunning new application for professional Web site
design. Designed to make the creation of great looking, interactive Web sites simple
and intuitive, Freeway blends immensely powerful production features with a familiar
user interface which together offer unrivaled ease-of-use and productivity.

Designers now have a quick and effective entry to the world of professional Web
design. First-time Freeway users become productive within a few hours and can focus
on designing elegant, exciting content with smooth site navigation, leaving Freeway to
manage HTML production.

HOW DOES FREEWAY WORK?
To produce a Web site with Freeway you simply create a new document and design
your pages using the powerful layout and typographic tools that the product pro-
vides.

On each page, you draws boxes of the desired shape which act as containers for the
content to be added. A box can hold either text, graphics or multimedia content
such as movies or animation, and can be positioned freely and accurately on the
page. User definable grids and ruler guides assist in the precise positioning of objects. 

The Multiple Master page feature will be familiar to designers who are working with
DTP and in Freeway it provides a tool to manage the styling of sections of the site as
you create it. This capability is one of the keys to the speed with which complex sites
can be created reliably and consistently with the added benefit of being able to make
sweeping changes to the site styling in minutes. 

As pages are being created, hyperlinks are added to text and images using Freeway’s
comprehensive system for assigning hyperlinks. The site palette plays an important
role in managing page sizes, links and site structure and is an invaluable aid to design-
ers as they produce their site.

Finally, the site is published into a destination folder as a set of HTML files along with
their associated graphic and multimedia files. Freeway uses extensively researched
techniques to ensure that the exported Freeway pages are faithfully reproduced in
browsers and uses HTML table commands as the basis for its pixel perfect control of
layout. You can preview the published site in a browser which can be activated from
within Freeway and once approved the site is uploaded to a Web server for publish-
ing on the Internet.

Creating a Web site in Freeway has many parallels with designing a document for
print using desktop publishing software. One of the important aspects of Freeway is
that a designer can produce a site with only a basic understanding of the Web and
how to navigate it. The user does not need to understand HTML, and Freeway
makes the whole task of Web design as accessible as possible. For example, unlike
many other Web authoring packages, Freeway does not insist that imported images
have been previously saved in GIF or JPEG format – you can import images in a wide
range of file formats commonly used in DTP (e.g. TIFF, PICT, EPS). After they have
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been imported, images are automatically converted to the most appropriate format
(either GIF or JPEG) and resampled to Web resolution. One benefit of this flexibility
of image handling is that graphic designers can save a great deal of time when they
take on jobs with both on-line and conventional design work by using the same origi-
nal material.

We developed Freeway for use in the production of Web sites with the highest pro-
fessional quality - comparable to the best that professional Web design companies
can produce today. To publish on the Web at this standard you normally need to gain
considerable experience of the intricacies of HTML and the peculiarities of HTML’s
behaviour in different browsers. Freeway customers do not have to invest their time
in this learning process – our engineering team has spent a great deal of time
researching the best techniques and tricks used by the Web design professionals and
have built these capabilities into Freeway.
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2. WHO WILL USE FREEWAY?

When we started this project we talked to many graphic designers about what they
wanted from a Web design application and what they couldn't get from the currently
available products. These people broadly fell into two groups. One group had little or
no experience of professional Web design – they may have used products like Adobe
PageMill and Claris HomePage or experimented with HTML but they had found the
experience unsatisfactory. The second group were designers and producers working
in established Web design companies, small and large, who were experienced in the
techniques and pitfalls of Web site design and production, typically using text editors
and graphics handling programs such as BBEdit and Adobe Photoshop.

A. DESIGNERS INEXPERIENCED WITH THE WEB
Designers who have not fully mastered the complexities of Web design constitute an
important market for Freeway. These are professional graphic designers with experi-
ence in print design but with little or no expertise in coding HTML and little desire
to devote their time and energy to mastering this technical skill before starting to
design for the Web. It is very clear, and no surprise, that graphic designers want to
spend their time designing rather than programming and expect their tools to sup-
port this design process. This is why, over the last ten years, Quark XPress has been
so successful in persuading designers to move from the drawing board to the
Macintosh - users see Quark XPress as a tool which allows them to express them-
selves creatively and does not interfere with this process. Our goal has been to make
Freeway a tool that persuades designers that they can at last move quickly and effec-
tively into the arena of Web design.

Freeway is a compelling proposition for very many designers. Our public beta pro-
gram has encouraged participants from all areas of the publishing and printing indus-
try as well as the education sector. Many of these people have had experience in
design and layout using professional layout programs such as QuarkXPress and
Adobe PageMaker. Beta users have ranged from design shops who have started to
offer Web design services for the first time through to printing companies whose in-
house designers are using Freeway to create their new Web sites. Other users
include publishers, prepress shops, advertising agencies and corporate design depart-
ments. 

WHY DO GRAPHIC DESIGNERS PREFER FREEWAY TO OTHER PRODUCTS?
Designer new to the Web quickly discover that first generation HTML editors such
as Adobe PageMill and Microsoft FrontPage do not measure up to their high stan-
dards of graphic design. For example the simple requirement for precise control in
positioning objects on a page can not be achieved with these products either quickly
or intuitively. To address this and related issues NetObjects developed Fusion and
GoLive developed CyberStudio. These products go some way towards satisfying the
needs of graphic designers but they still fall short of providing a compelling solution.
With the development of Freeway, SoftPress has given graphic designers their first
real chance to apply their full range skills and experience to the Web. 

In the points below we have summarised the key functionality of Freeway which dis-
tinguishes it from products like Fusion and CyberStudio. It is claimed that both of
these competitive products address graphic designers' needs through their Web page
layout controls but, in our opinion, they fall short in some significant areas. Freeway's
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strength as a designer's tool for the Web is founded on a combination of three areas
of functionality which is unique to Freeway:

■ A user interface and way of working which is intuitive to graphic designers
who use DTP products like Quark XPress and Adobe Photoshop daily. With
Freeway they can become productive in just a few hours.

■ A rich set of layout, design and typographic tools which are unrivalled in the
arena of Web design and provide a new level of creative freedom and control.

■ Intuitive and powerful productivity tools, for example features for creating anti
aliased GIFs from editable text and WYSIWYG optimisation of GIF and JPEG
image quality against file size.

These features complement Freeway's strengths in generating reliable and efficient
HTML to provide a complete solution for Web site design. 

Expert features are another important component of Freeway and are of specific
interest to experienced Web producers and HTML-ers. Freeway provides the capa-
bilities to add customised code and scripts (eg HTML, Java Scripts) so the power and
functionality of Freeway is essentially unlimited.

WHAT DESIGNERS ARE SAYING ABOUT FREEWAY

Here are a few quotes from Freeway users which illustrate the uniqueness of
Freeway rather effectively. They come from designers who downloaded the public
beta and, without any contact from us, sent email to express their enthusiasm for
what Freeway offers.

“Congratulations on a superb application! I downloaded freeway beta yester-
day afternoon and within three hours I was navigating my test document like I
had been working with it for weeks. This is a revelation for designers with no
html skills. At last I can design web sites for our clients without the rigid, grid-
like structure of other lesser  applications. I look forward to the full version of
this well designed, intuitive application.”
Marc Rocca, Graphic Designer, The Million Company, Sheffield,
England 

“Let me preface these responses by saying that your software is a life saver for
graphic artists who are just getting into web design and do not want to learn
from scratch. I love the flexibility of layout control that I have.”
Jon Rodda, Graphic Designer, Syracuse Printing Co., Syracuse, IN
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“It’s hot, and I love working with it! I've done a lot of print pre-press the past
six years, and Freeway is just as easy (maybe even easier!) than QuarkXPress.
You folks have done a terrific job. I hope you sell a million copies.”
Mike Kreffel, Cartoonist/Designer, Indianapolis

“What a fantastic application! At last, something that looks good and allows
precise control - I'm impressed and want the full version when it ships”
Paul Harmer, Freelance Photographer, London

“Well. What can I say? The more I have used Freeway, the more I have come
to appreciate it! I really think this is a winner. Having finished the company
web site and uploaded it, I think my 'bug testing' is done for the time being. I
will 'play' with it again before shipping date and I'm itching to have a go at
more”
Heather Kavanagh, Scarbutts Printers, Kent, England
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B. WEB-SAVVY DESIGNERS
Amongst this group of designers, the biggest competitor to Freeway is arguably
BBEdit – the text editor of choice amongst Mac-based Web producers. Much of the
professional Web site production industry uses hand coding of HTML as the basis for
their production process whether it is a one person company or a major Web design
company employing 50 people. It is quite common to hear Web site producers say
that there is nothing better than the flexibility of hand-coding HTML and this state-
ment has some truth in the context of producing the leading-edge web sites in which
the experts specialise.

Having said that, the experience we have gained with the Freeway beta program over
the last six months tells us that our product can provide substantial time savings in
even the most advanced Web production company. Freeway efficiently performs
tasks which are valuable to any Web site production process - here's just four of
them.

PROTOTYPING

Producing concept sites for clients can be time consuming. There is frequently as
much work in producing a rough sample as there is in producing the finished piece.
Because of the rapidity with which a site can be designed and constructed in
Freeway, and more importantly because of the speed and ease with which global
changes can be made to a site , a Web design company can quickly design and pro-
duce a variety of alternative concept sites. These can be built complete with naviga-
tion links in far less time than a single prototype could be produced by hand-coding
and the length of the client approval cycle can be dramatically reduced.

CREATING GRAPHIC PAGE ELEMENTS

In commercially produced Web sites, the creation and production of graphic and
typographic elements is carried out in other applications, such as Photoshop. These
applications do not have the same level of layout, typographic control and flexibility
as is available in a professional layout application such as Freeway. In short, you can
produce typography, simple graphics and combination graphics in one Web design
application - Freeway - and this comes from Freeway's unique abilities to export
editable text as anti-aliased Web-ready graphics, to overlap page elements and to
output the whole as a high quality Web-ready graphic.

PROCESSING IMAGES.
Web publishing professionals need to take a great deal of care with images published
on the Web. They make graphic files as small as possible, consistent with maintaining
image quality, so that they download efficiently. Another important production issue
is to ensure that the colors used in images reproduce correctly across the wide vari-
ety of display environments found on the Web. Freeway does this automatically and
allows inexperienced users to achieve best quality results. This feature also provides
substantial time savings for the established Web design shop because this time con-
suming and repetitive task can be undertaken in this one application.

Freeway offers a further advantage over other tools through its WYSIWYG
approach to optimizing file size against quality. When the file size, color palette, num-
ber of colors or compression level of images need to be altered, an interactive
graphic preview is available which gives feedback on exactly what effect changes being
made are having on the graphic quality in real time. This saves the time consuming
trial and error process inherent in the use of other tools which normally do not
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offer visual feedback.

DESIGNING TEMPLATES

Freeway offers a free form approach to Web page layout which the Web professional
can exploit to create templates for a site quickly and efficiently. Using Freeway a Web
site producer can greatly reduce the time spent defining and altering basic layouts
which are repeatedly used to form the basis for many pages in the site. Using this
technique the producer has control over Web page layout and design independent of
content. The Freeway User Guide is a simple example of how this can be applied.
We produced the original files of our User Guide in Adobe PageMaker so that a
printed version could be available as well as on-line versions in PDF and HTML. The
PageMaker files were exported both as a PDF and in HTML format. The HTML files
were then poured into stylized templates which were designed with Freeway.
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3. GETTING STARTED WITH FREEWAY

WHAT DO I NEED ?

YOUR COMPUTER

An Apple Macintosh or other MacOS-compatible computer with a 68040 or
PowerPC Processor, CD-ROM drive, and a hard disk with at least 20MB free

RAM REQUIREMENTS

After the system software has loaded, you need:
68040 - at least 5MB free
PowerPC  - at least 9MB free

COMPUTER VIDEO

800x600, 256 Colors is suggested, but ideally you should have a multiple scan moni-
tor and be able to drive it at up to at least 1024x768, 24-bit color.

WEB BROWSER SOFTWARE

You require one or both of the following Web Browsers in order to view the pages
you make with Freeway, preferably in a selection of different versions:
Netscape Navigator
Microsoft Internet Explorer
(both version 3.0 or later)

REQUIRED SOFTWARE

System 7.5.1 or later
Apple ColorSync 2.0 (supplied via custom install)
Apple GXGraphics (supplied)
plus to use Type 1 PostScript fonts:
Adobe Type Manager 3.8.3 or later
SoftPress Type 1 Works (supplied)

HOW TO INSTALL

TO INSTALL FREEWAY

1. Insert the Freeway CD into your computer.
2. When the open window appears on your desktop, find the installer icon

Freeway 1.0 Installer and double-click to open it.
3. Choose between Easy Install and Custom Install. Easy Install is recom-

mended for most customers, and includes all the files necessary to run
Freeway, plus the help files and documentation.

4. If necessary select a different destination drive to install to.
5. Freeway will be installed to a folder at the top level of the specified vol-

ume, but you can change this if you wish.
6. Click the Install button. You need to restart the computer once the

installation is complete.
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WHAT GETS INSTALLED

When you install Freeway using the Easy Install option, a new folder is created at the
top level of the destination drive containing the following items:

• The Freeway application - either Freeway™ 1.0 (PPC) or Freeway™ 1.0
(68K) depending on your computer

• Freeway Readme - a SimpleText file containing this information, plus any
late-breaking information

• Help - a folder containing the online help and User Guide in HTML format
• Freeway User Guide.pdf and Getting Started.pdf - the User Guide

and Getting Started booklet for Freeway in Adobe Acrobat PDF format for
viewing or printing

• Freeway Tutorial Folder - contains the resources required to complete
the tutorial exercises

• Utilities - a folder containing SoftPress System Info, which generates a
report on your system in order to help support personnel to diagnose any
problems

• Dictionaries - for spellchecking and Hyphenation in UK and US English. 
In addition, the following items may be installed to the Extensions Folder in your
active System Folder:

GXGraphics, SoftPress Type 1 Works
GXGraphics is a library of graphics routines which is required for Freeway to run. If
this is removed, Freeway will not launch.

TROUBLESHOOTING
In the unlikely event of any problems occurring after you install Freeway, refer to this
section to see if the problem is referred to here. If not, point your browser at
http://www.softpress.com/support  or contact us by email at support@softpress.com

The areas covered are:
error messages on startup
freeway gives an error message and won’t launch
freeway crashes whilst opening

ERROR MESSAGES ON STARTUP

If you encounter the following messages on starting the computer, see the informa-
tion on the following pages regarding the 3rd-party software referred to:

"The installed substitution fonts are designed for use with Standard
QuickDraw. Please remove them and install the QuickDraw GX versions." 
- Adobe Acrobat 3.0 or previous is installed - see the section on
Adobe Acrobat below.

"QuickDraw GX will not be active because it's printing system is not installed."
- Apple Desktop Printing version 1.03 is installed - see the section
on Apple Desktop Printing below.
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FREEWAY GIVES AN ERROR MESSAGE AND WON’T LAUNCH

If you receive a message when you try to open Freeway, and Freeway fails to launch,
it is likely that some required software is missing.

“It seems GXGraphics is not installed. Please install or reinstall and then try
again.”

This means that the GXGraphics extension, which is required to run Freeway, is not
present in your system folder, or has not loaded. Ensure that the extension
GXGraphics is present in your System Folder and then restart your computer. If the
message still appears when you try to launch Freeway, contact SoftPress Support.

“ColorSync™ is either not installed or is too old. Please use version 2.0 or
newer.”

ColorSync is part of the system software supplied as part of the MacOS, and version
2.0 or later is required for GXGraphics and Freeway to operate.Ensure that
ColorSync 2.0 is correctly installed, and then restart your computer and try again. If
you have any questions, or are unable to locate ColorSync 2.0, contact SoftPress
Support.

FREEWAY CRASHES WHILST OPENING

Freeway is a very stable application, and if you do find that Freeway is crashing, quit-
ting unexpectedly, or freezing during opening, the cause is almost always either a
clash with some 3rd party software installed on your computer, or a bad or corrupt-
ed font.

SOFTWARE CLASH

If the problem is due to a software clash, the culprit is likely to be a 
3rd-party extension or control panel installed in your active System Folder. To trou-
bleshoot this, you can try restarting without any 3rd-party extensions or control
panels installed, but you must remember that ColorSync 2.0 and GXGraphics are
required for the correct operation of Freeway, as well as Adobe Type Manager (plus
the SoftPress Type 1 Works extension for versions of ATM prior to 4.0.2) extension
if Type 1 PostScript fonts are to be used. If you are not familiar with troubleshooting
software clashes in this way, contact SoftPress Support for assistance before you pro-
ceed.

BAD FONTS

Freeway needs to read through the fonts available on your system as it starts, and it
may encounter a problem if one of the fonts is damaged. Note that damaged fonts
may not necessarily cause problems in applications other than Freeway.
To see if this is causing your problem, you can temporarily turn off any font manage-
ment software you may be using, and drag the fonts folder out of your system folder
to the desktop, then restart your computer. If Freeway then launches successfully,
you know that a bad font was causing the problem, and can then try to isolate which
one it was by a process of elimination.
Note that when you restart, a new fonts folder is automatically created. As long as
you don’t add any fonts to this new one, and are careful not to get the real fonts
folder and this new one mixed up, you can allow it to be overwritten when you
move the real fonts folder back into the System Folder.
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THIRD-PARTY SOFTWARE ISSUES
When you install Freeway and its required extensions, you may encounter some
unexpected error messages, or there may be issues with 3rd-party applications and
utilities you need to be aware of.  The common issues are documented below.

ADOBE TYPE MANAGER

In order to gain access to your Type 1 PostScript fonts from within Freeway, you
must have version 3.8.3 or later of Adobe Type Manager installed, as well as the
SoftPress Type 1 Works extension. Without this extension, Freeway will not be able
to use Type 1 fonts.
Alternatively, if you have version 4.0.2 or later of Adobe Type Manager, this will not
require the SoftPress Type 1 Works extension.

ADOBE TYPE REUNION

Adobe Type Reunion is not compatible with Freeway, and must be disabled while
running Freeway. If you have Type Reunion 2.0 Deluxe, you can disable it for selected
applications - go into the Type Reunion Control Panel, select the Compatibility tab,
and add Freeway to the list of excluded applications using the Add button at the
lower right.

ADOBE ACROBAT

After restarting your machine with GX Graphics loaded, you may see an error mes-
sage on startup if you have Adobe Acrobat installed:

"The installed substitution fonts are designed for use with Standard
QuickDraw. Please remove them and install the QuickDraw GX versions."

This error message, which is generated by Adobe Type Manager, is misleading. The
simple solution is to reinstall Adobe Acrobat. Alternatively you can upgrade to
Adobe Acrobat 3.01 which resolves the problem. The cause of the problem is an
incompatibility between Adobe Acrobat 3.0 or earlier and the GX Graphics exten-
sion. When Acrobat is installed the set of substitution fonts used depends on
whether GX Graphics has already been installed. If GX Graphics is installed after
Acrobat then the wrong substitution fonts will be found. Reinstalling Acrobat will
replace these with the correct fonts.

APPLE DESKTOP PRINTING

If Apple Desktop Printing is installed when you start your machine with GX Graphics
loaded, you may see the following message:

"QuickDraw GX will not be active because it's printing system is not
installed.", and your desktop printer icons will be crossed out on the desktop. 

This happens with version 1.0.3 of Desktop Printing, which is not compatible with
the GX Graphics extension. To resolve the problem, either restart without the
Desktop Printing extensions listed below, or upgrade to Apple Desktop  Printing
2.0.1 or later, which resolves the conflict.

ADOBE PAGEMAKER 6.5
Adobe PageMaker 6.5 will report the following error message when you choose the
Print command while GXGraphics is active:

“PageMaker 6.5 does not support and is not compatible with the version of
QuickDraw GX installed on this computer. Remove QuickDraw GX and
restore Type 1 fonts to ensure proper printing from PageMaker.”

However, the message is erroneous, and clicking the Print anyway button will allow
you to proceed and print as normal.
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4. FREEWAY TOUR

This section introduces the basic concept of Freeway, describes the main parts of the
Freeway interface, and gives a step-by-step workthough of how to create a site using
the product. The workthrough uses files and instructions based on the Freeway tuto-
rial, which is described in the Getting Started booklet.

BASIC CONCEPT
The basic concept of Freeway differs from most other Web authoring tools. Freeway
does not edit HTML directly. Instead, the user creates a document within Freeway,
within which they can define pages. They import text, graphic and multimedia files
onto these pages, and create Hyperlinks to enable the site to be navigated.
When the user wishes either to publish the site on the Web, or preview how it
looks in a Web browser, Freeway exports the entire contents of the document as
individual HTML files, along with the associated GIF, JPEG and other files suitable for
the Web, into a destination folder which the user must specify, called the Publish
folder.
It is the contents of this Publish folder which need to be uploaded to the user’s Web
space.
Freeway works in a similar way to page layout programs, so for example where one
might lay out a magazine in QuarkXPress, then print it to PostScript, using Freeway
one lays out a Web site and Publishes it to HTML.
Freeway cannot be used to edit an existing site which already consists of HTML files,
nor can HTML pages be imported into Freeway documents so as to retain their con-
tent and layout on the Freeway page. HTML import is a feature planned for a future
release of Freeway.
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ZOOM TOOL

GIF RECTANGLE TOOL

SELECTION TOOL

HTML RECTANGLE TOOL

OVAL BOX DRAWING TOOL

TEXTBOX LINKING TOOL

PEN TOOL

TRANSFORM TOOLS

TEXTBOX UNLINKING TOOL

FORM CONTROL DRAWING TOOLS

SCREEN TOUR

THE FREEWAY INTERFACE

THE TOOLS PALETTE

1
2

6

3

4

58 97

1. Tools Palette
2. Page
3. Inspector Palette
4. Colors Palette
5. Site Palette

6. Pasteboard
7. View popup menu
8. Page popup menu
9. Status line
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1

2

2. SWITCH TO THE MASTER PAGE

Switch to the default master page using the page
popup menu at the bottom of the window.
Alternatively, you could click on the icon for
Master1 in the Site palette.

3

3. SET UP RULER GUIDES

Drag ruler guides onto the page, and double click
them to display the guide dialog - you can either
check the existing position, or enter a new value to
reposition guides.

4

4. APPLY A BACKGROUND IMAGE

You can apply a background image in GIF or JPEG
format which tiles automatically to fill the browser
window. Freeway ensures that elements on the page
keep their position with regard to the background in
as many browsers as possible.

5

5. IMPORT AN IMAGE

You can import a wide variety of standard images
into Freeway, including TIFF and PICT, which are
automatically converted to either GIF or JPEG on
export, whichever is most appropriate depending on
the image.

1. CREATE A NEW DOCUMENT

Choose New from the File menu to bring up the
Document Setup dialog and select a page size. You
can also setup margin guides, specify 8.3 or long file-
names, and specify an output folder for the HTML
output that will be generated.

CREATING A WEB SITE 
WITH FREEWAY

The following steps show how a simple Web site
might be created with Freeway, using the exercise
files from the Tutorial - for more information
about any of the steps, or for detailed instruc-
tions, see the Getting started booklet supplied
with Freeway.
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7

8

8. SET UP LINKS TO NEW PAGES

Hyperlinks can be applied to any run of text or any
box in Freeway by highlighting some text or making a
selection and then choosing Hyperlink from the Edit
menu. Internal links can be established either to
existing pages or to new pages created as you link to
them (as above).

9

9. NAMING PAGES AND FILES

Each page in Freeway can be given a title which iden-
tifies it in the document and also appears as the win-
dow title in the browser. The filename for the
resulting HTML file is automatically created from
this, but can be replaced by one of the user’s own
choice as above.

10

10. ADD CONTENT TO THE PAGES

Adding content is easy in Freeway - just draw boxes
to hold text, graphics or multimedia elements. You
can also tell Freeway to reference an external URL
in a box, for example using <IMG> to insert a ban-
ner graphic from another server.

11

11. CHECK INTERNAL LINKS

You can check the internal navigation of your site
without launching a browser by using the Follow
Link command from the Edit menu while you have a
selection which is a hyperlink. You can also 
Cmd-click the page icon in the status bar to jump
to the linked page.

7. CREATE SOME HTMLTEXT

Text can be exported as conventional HTML text as
well, with a wide range of HTML formatting com-
mands applied to it. The user can choose what
default fonts are used to preview HTML text in
Freeway using the Preferences settings.

6

6. CREATE SOME GIF TEXT

Text in Freeway can be exported as Anti-Aliased
GIF graphics automatically when the site is built, giv-
ing access to a full range of sophisticated typograph-
ic commands. The text remains editable in Freeway
at all times, and the user can even preview what the
exported text will look like.
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12

14

14. PREVIEW THE SITE IN A WEB BROWSER

At any point during production you can preview the
site in your favorite browser. Any elements changed
since the last time the site was built using the
Publish or Preview commands are re-exported, but
not elements which remain unchanged.

15

15. CHECK THE SITE APPEARANCE AND LINKS

You can view the site in your browser, checking the
appearance of the pages and checking links to make
sure they work. Animated GIFs and multimedia ele-
ments can be previewed in the browser.

16

16. CHECK THE FILE SIZES

Once the site has been published or previewed,
Freeway is able to report back on the resulting file
sizes for the page including all graphics, and for indi-
vidual graphics, using the Site palette and the “Show
File Sizes” option. “Show Items” is turned on above
to show sizes for graphics as well as pages.

17

17. UPLOAD THE SITE FILES TO A SERVER

Once the site is complete, and has been previewed,
it is then ready for upload to a Web server, using
Fetch or Anarchie for example.

12. CHECK ALIGNMENT WITH BACKGROUND

When the page is viewed in the browser, there is an
extra margin of 8-9 pixels inserted at the left and
top, which makes positioning of elements harder. To
overcome this, you can turn off Clip Background
from the View menu to preview the actual area of
the background as seen in the browser.

13

13. PUBLISH THE SITE AS HTML

Before the site can be viewed in a browser, it must
be exported from the Freeway document as HTML
- this is done using either the Publish command or
the Preview command, both on the File menu. The
site is built into the destination folder specified in
Document Setup.
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5. FREEWAY ESSENTIALS

This section describes some of the essential concepts behind working in Freeway.
For more information on any of these topics, see the online help.

A. CREATING A NEW DOCUMENT

When you create a new document , the most important decision to make is choos-
ing the page size. Either select one of the predefined page sizes from the popup
menu. or type your own preferred values for the width and height of the Web pages
you wish to create. This determines the default size for new pages created in
Freeway. You can override the default page size at any point after the document has
been created, either for individual pages using the Inspector palette's page panel, or
for the whole document using the Document Setup dialog on the File menu.

B. CREATING CONSISTENT NAVIGATION AND APPEARANCE

To control the appearance of all the pages in your document, it’s best to use Master
pages. Each page in your document takes its default settings from a master page, and
you can create as many master pages as you need to, for example to control the
appearance of individual sections of your site. Objects on a master page are automat-
ically copied onto any real pages which are based on it, and the real page will use the
master page’s Page settings, including size, background color, background image, link
colors and so on.

C. CREATING AND MODIFYING ITEMS ON A PAGE

To place any content on a page in Freeway, you need to create containers for that
content by drawing boxes. Freeway offers a variety of drawing tools in the Tools
palette to draw boxes. Any box can hold either text, graphic or multimedia content.
When the document is published to the Web, the items you have created in this way
can be exported in a variety of ways. The method used to export each items isdeter-
mined by it’s Export type, shown in the Export panel of the Inspector palette whilst
the item is selected.
When you create a box, it is left selected, and the drawing tool reverts to the selec-
tion tool. While the box is selected, you can move it using the selection tool, or use
the selection handles to resize it. You can also apply Transformations, change the fill
color or apply a border to it.
To deselect an item, click on an empty area of the page or pasteboard using the
selection tool, or use a drawing tool to create another box. To select an item, use
the Selection tool. You can either drag a selection rectangle around one or more
objects, click on the very edge of a box using the selection tool, or hold down the
Command key whilst you have any tool selected, and click anywhere inside the box.
To delete an item, you select it using one of the above methods, then choose
Edit/Clear or press the backspace or delete key on the keyboard.

D. CREATING NEW PAGES

To create new pages, use the New Pages... command, found on the Page menu, and
also on the Site Palette popout menu. When creating new pages, you can specify
how many pages you wish to create, which master page they will be based on, and
what title they will have. 
Pages are named in Freeway using the Title field in the Page panel of the Inspector
Palette. The value for Title will also be used as the Window title of the Web page
created from it, when the page is viewed in a browser.



When specifying a title as you create multiple new pages, the pages will share the
same title, but it will be suffixed with the numbers 1,2,3 and so on.
To delete a page, bring up the Site palette and click on the page title in the palette to
highlight the page, then choose Edit/Clear or press Backspace or Delete.
To change page, you can click the page icon of the page you want to go to in the Site
palette, or select the page you want to go to from the Page popup menu at the bot-
tom of the document window.

E. USING MASTER PAGES

When you create a new document, it starts out with one real page and one master
page. Any new pages created are based on the default master Master1, but if you
have more than one master page, you can choose which master new pages will be
based on. New masters you create take their settings from those originally specified
for the document when it was created, but you can change these at any stage using
File/Document Setup.
To create a new master page, use New Master... from the Page menu or Site palette
popout menu.

F. ENTERING AND MODIFYING TEXT

To enter text on a page, you must draw a box to contain it. Any box can contain
text, even oval boxes or boxes drawn with the pen tool, unless it already contains
graphic or other content.
Normally, you draw a rectangular box to hold text, using one of the two rectangular
box drawing tools. These tools differ in that they create boxes with different default
export types  - the blue rectangle box tool on the left creates boxes whose text con-
tent will be exported as normal HTML text, whereas the grey box tool on the right
creates boxes whose text content will automatically be exported as a GIF bitmap
graphic.
To enter text, select one of the box tools, click and drag diagonally on the page to
define the size of the box, then click once inside the box to create a flashing textin-
sertion point, and begin typing. 
To apply formatting to text, you must highlight the text using the Selection tool.
When the selection tool cursor is over a box which contains or can contain text, it
becomes an I-beam to show that you can edit the text. Drag across the text to high-
light it, and then apply the options of your choice using the Style menu or the Text
panel of the Inspector Panel.

G. IMPORTING AND MODIFYING GRAPHICS

To import a graphic, draw or choose any box created with the Freeway drawing
tools, and ensure that it is selected with its handles visible. Go to the File menu and
choose Import.... In the resulting dialog, locate the graphic you wish to import and
click Open.
Freeway always processes imported graphics and converts them to either GIF or
JPEG as appropriate. You can override its choice using the Export panel in the
Inspector palette if necessary. If you have a GIF or JPEG graphic which you do not
wish to be affected by Freeway’s export procedure, you have the option of importing
it for “Pass-through”. When you import an image for pass-through, you cannot
change it’s size, rotation, cropping, or overlap it with any other object, nor can you
alter it’s settings for colors, color palette, compression etc.
Pass-through images may only be imported into rectangular boxes, and the box must
be large enough to hold the graphic. If the box is too small the graphic will overflow,
shown by a large blue cross through it.
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You can use various commands to resize or position graphics within their box - these
commands and their shortcuts are shown on the Item/Graphics submenu.
Imported graphics which are imported normally, i.e. not as pass-through, will be con-
verted to either GIF or JPEG format when the site is published to HTML. Which for-
mat is used by default depends on the color depth of the original image that is
imported. Images with greater than 256 color depth are automatically set to export
as JPEG format, whilst images with 256 colors or less are automatically exported as
GIF format. You can set the export options for each, and switch between the two
export types, using the Export panel of the Inspector palette.

H. IMPORTING MULTIMEDIA CONTENT

To import a multimedia element, draw or choose any rectangular box created with
the Freeway drawing tools, and ensure that it is selected with its handles visible. Go
to the File menu and choose Import.... In the resulting dialog, locate the element you
wish to import and click Open.
Freeway will allow you to import any file that is supported by a Netscape plug-in, and
it shows a Netscape plug-in icon inside the box containing the element. To preview
the plug-in content, you must view the exported HTML page in a Web browser.
Boxes containing plug-in content may not be transformed or overlapped with other
boxes.
Previewing plug-in content in place on the Freeway page is a feature being considered
for a future release of Freeway.

I. CREATING HYPERLINKS

To define an internal link to an existing page using the Hyperlinks dialog
1. Highlight the text, or select the box that you wish to apply the Hyperlink to
2. Choose Hyperlinks from the Edit menu (Cmd+K)
3. Select a page from the list of Existing Pages and click OK
4. The link will be indicated by blue and underlined formatting for text, or by dis-
playing a link icon in the top left corner of boxes, as appropriate, and the link will be
displayed in the status line at the foot of the document window when the text is
highlighted or the box is selected.

To define an external link using the Hyperlinks dialog
1. Highlight the text, or select the box that you wish to apply the Hyperlink to
2. Choose Hyperlinks from the Edit menu (Cmd+K)
3. Choose the appropriate link type from the URL popup menu, and type or
copy/paste the link reference into the text field provided.
If creating a relative reference, do not specify a link type. Ensure that the reference
completely replaces the default text “http://” in the text field.
4. The link will be indicated by blue and underlined formatting for text, or by dis-
playing a link icon in the top left corner of boxes, as appropriate, and the link will be
displayed in the status line at the foot of the document window when the text is
highlighted or the box is selected.

J. IMAGE MAPS

Freeway allows the creation of Client-Side image maps using the same box drawing
tools used to create GIF items on the Freeway page to define hot-spots on the
image.
To create an image map, draw a box and import the graphic into it. Resize this and
position it on the page as you require.
Next, select the box drawing tool of your choice, depending on the shape of the hot-
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spot you wish to define. You can define hot-spots using the GIF rectangle box draw-
ing tool, the oval drawing tool, or the pen tool. Define the box over the area  you
wish to become a hot-spot, and then with the box still selected, define a Hyperlink
for the empty box, according to the instructions in the section above.
Freeway automatically understands that an empty GIF box over a graphic should
become a hot-spot in an image map, and defines the appropriate HTML commands in
the output.

K. OVERLAPPING ITEMS ON THE FREEWAY PAGE

Objects on a Web page cannot be overlapped with one another, (except using the
new Layers standard which has yet to receive widespread support) - however,
designers need to be able to work outwith this artificially imposed limitation on their
creativity. Until now, there was no solution to this problem, which Freeway neatly
side-steps.
Although the objects on the Web page may not overlap, items in Freeway can.
Through innovative programming and software design, Freeway allows the Web
designer to create any combination of layout objects, and then deals with that combi-
nation as best it can using techniques learnt from professional Web designers. Whilst
working, the user is assured of a screen preview which gives a clear view of the final
output .

L. OVERLAPPING GRAPHIC ELEMENTS WITH EACH OTHER

When two graphic objects are overlaid, Freeway deals with this when the site is pub-
lished by exporting the two overlaid items as a single composite graphic. It is this
ability to seamlessly combine graphic objects which gives rise to much of the creative
freedom Freeway offers. When two graphic objects are overlaid, a new kind of
object is created within Freeway - an Image Group. The items themselves are
unchanged, and can be moved or edited as freely as before.

Image groups are created and decoupled automatically as the user works in Freeway.
When two or more graphic objects overlap to create an image group, this is shown
by a new dotted line outlining the bounds of the new graphic which will be created
on export, and a new panel appears in the Inspector Palette, the Group Export
panel. This is used to set the export options for the new image that will be created. 

When an image group is formed, the dominant image in the group is the rearmost in
the stack of objects. It's title influences the filename of the export image. The Group
Export panel appears whenever one of the items in an image group is selected, and
the options which are used are those of the dominant object in the group. Any
changes to the settings made in that panel are saved into the dominant item in the
group. If the dominant object is an item with an export type of JPEG, the image cre-
ated on export will be a JPEG. If the dominant object is an item with an export type
of GIF, the image created on export will be a GIF. 

While part of an image group, items also show the original Export panel in the
Inspector palette, but the only options here are for selecting the export type.

M. OVERLAPPING HTML TEXT BOXES WITH GRAPHIC ELEMENTS

Again, HTML text boxes cannot be reproduced in the output overlapping any other
element on the Web page, but they can be moved on top of graphic elements on the
Freeway page. If this happens, then the HTML text box will cut a "hole" through the
underlying graphic element, revealing the page background. 
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This is represented by accurate feedback within Freeway. In addition to reproduce
this in the output, the graphic element on the Freeway page is automatically cut up
horizontally and exported as individual images.

When this happens, there are certain circumstances in which the parts of the image
may get pushed apart when viewed in the browser, for example if the text inside the
HTML text box is viewed at a large size in the browser window.

To avoid this, it is suggested that any HTML text boxes which are made to overlap
graphic elements on the page are sized so as to allow plenty of room for the text to
grow before it begins to "stretch" the layout. To help the user judge when an HTML
text box may potentially cause graphic elements to split, there is a specific preview
otpion on the View menu called HTML Layout which shows the cuts that will be
made across the graphic element in question. If there is risk of separation, red
arrows displayed over the affected elements alert the user to this.

N. OVERLAPPING HTML TEXT BOXES WITH EACH OTHER

When HTML text boxes are overlapped with each other, Freeway deals with the
output by building elaborate HTML table constructs. Any text in the underlying text
box gets pushed down so as to overflow if necessary. It is not possible to have HTML
text wrapping neatly round the side of an overlapping box using Freeway 1.0,
although we are investigating means by which this could be achieved in a future ver-
sion.
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